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1. การพัฒนาแบบสอบถาม

• เราถามเพื่ออะไร

• ต้องการวิเคราะห์อะไร

• เพื่ออะไร

1) คำถามต้องชัดเจน เข้าใจง่าย ส้ันกระชับ และมีใจความเดียว

2) จำนวนคำถามในแบบสอบถามต้องไม่มากจนเกินไป เพื่อใช้เวลา

น้อยท่ีสุดในการตอบคำถาม
3) คำถามควรหลีกเล่ียงคำถามนำ เช่น   “เกษตรกรส่วนใหญ่ปลูก

ข้าว” ท่านเห็นด้วยหรือไม่ 
4) ควรจะมีการกำหนดความถ่ี สำหรับคำถามเก่ียวกับความถ่ี เช่น  

“1-2 ครั้ง”  แทนคำว่า “บ่อย ๆ”

5) ควรมีการถามถึงข้อมูลส่วนบุคคลหรือสถานภาพส่วนบุคคล เพื่อ
ช่วยในการวิเคราะห์ความสัมพันธ์กับคำถามอื่น ๆ เช่น ความ

คิดเห็นในเรื่องต่าง ๆ หรือพฤติกรรมการใช้จ่าย

หลักเกณฑ์ในการสร้างแบบสอบถามคำถามท่ีต้องถามก่อนสร้างแบบสอบถาม



การอบรมการวิเคราะห์สถิติเบื้องต้นด้วยโปรแกรม EXCEL 4

2. รูปแบบของคำถาม

1. คำถามท่ีมีคำตอบให้เลือก 2 ทาง (Dichotomous Questions)

เช่น   “ปัจจุบัน ท่านใช้ปุ๋ยตราวัวแดง ใช่ หรือ ไม”่ ใช่ ไม่ใช่

2. คำถามท่ีมีหลายคำตอบให้เลือก (Multiple Choice Questions)

เช่น   “การศึกษาสูงสุดของท่าน”

มัธยม                    ปริญญาตรี   สูงกว่าปริญญาตรี
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2. รูปแบบของคำถาม

3. คำถามท่ีผู้ตอบเลือกได้หลายคำตอบ (Checklist Questions หรือ Multiple Responses)

เช่น “ท่านซ้ืออาหารจากแหล่งใดเป็นประจำ  (เลือกได้มากกว่า 1 คำตอบ)”

ตลาดสดแถวบ้าน ห้างสรรพสินค้า                  ร้านข้างทาง

4. คำถามท่ีให้ผู้ตอบใส่ลำดับท่ี (Ranking Questions)

เช่น “ท่านซ้ืออาหารจากแหล่งใดบ่อยท่ีสุด  (1) ไปจนถึงน้อยสุด (3)

ตลาดสดแถวบ้าน ห้างสรรพสินค้า                  ร้านข้างทาง
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5. คำถามประเมินความเห็นหรือความชอบ (Scale Questions)

2. รูปแบบของคำถาม
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ส"วนท่ี 1 ข+อมูลการบริโภคเน้ือสัตว= 
BEH1. ทMานชอบรับประทานเนื้อสัตวFประเภทใดมากที่สุด 

☐ 1) เนื้อไกM   ☐ 2) เนื้อหมู   ☐ 3) เนื้อวัว  ☐ 4) เนื้อปลา / ทะเล  ☐  5) อื่น ๆ................. 

BEH2. ความถี่ในการรับประทานเนื้อวัว 

☐ 1) รับประทานเป`นประจำ      ☐ 2) รับประทานบ9างนาน ๆ ครั้ง     ☐ 3) ไมMรับประทานเนื้อวัว 

BEH3. คMาใช9จMายด9านอาหารเฉพาะตัวทMานในการซื้ออาหารประมาณ ............................ บาท/วัน 

BEH4) รูปแบบการรับประทานอาหารของท6านและครอบครัวในช6วง 1 เดือนที่ผ6านมา 
 บ6อยมาก/ประจำ นาน ๆ ครั้ง ไม6เคย 

☐ 1) ทำกับขKาวทานเอง ☐ ☐ ☐ 

☐ 2) ซื้ออาหารสำเร็จรูปมาทานที่บKาน  ☐ ☐ ☐ 

☐ 3) ทานอาหารนอกบKาน  ☐ ☐ ☐ 

BEH5. ทMานชอบรับประทานเบอรFเกอรFชนิดใดมากที่สุด (เลือกตอบเพียง 1 ข9อ) 

☐ 1) หมู       ☐ 2) ไกM     ☐ 3) เนื้อ  ☐ 4) ปลา ☐ 5) มังสวิรัติ 

BEH6. ชุดเบอร์เกอรท์ี่ท่านรับประทานเป็นประจำราคาประมาณ ............................ บาท/ชุด 

BEH7. ในชMวงเทศกาลกินเจ (ตุลาคม 2563) ทMานได9รับประทานอาหารเจหรือไมM  

☐ 1) กินเจตลอดเทศกาล  

  ☐ 2) ไมMได9กินเจ แตMสามารถกินอาหารเจได9 

☐ 3) ไมMกินอาหารเจเลย 
 

ส"วนท่ี 2 ความเห็นต"อการรับประทานเน้ือสัตว=และโปรตีนจากพืช 
คำช้ีแจง : ขอให.ท$านอ$านข.อความด.านล$าง แล.วทำเคร่ืองหมาย   √  ในช$องท่ีตรงกับความคิดเห็นของท$านมากท่ีสุด 

รายการ      
ไม#เห็นด)วย
อย#างย่ิง 

ไม#เห็นด)วย ไม#แน#ใจ เห็นด)วย เห็นด)วย
อย#างย่ิง 

1. เนื้อสัตว์อร่อย      

2. เนื้อสัตว์เป็นแหล่งโปรตีนสำคัญของร่างกาย      

3. การรับประทานเนื้อสัตว์มากส่งผลต่อน้ำหนักตัวที่
เพิ่มขึ้น 

   
  

4. การรับประทานเนื้อสัตว์มากส่งผลเสียต่อสุขภาพ      

5. เพื่อลดความเสี่ยงด้านสุขภาพ ท่านสามารถมาลดและ
เลิกการบริโภคเนื้อสัตว์และผลิตภัณฑ์ได ้

   
  

ID 
_______________ 
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1. การเก็บรวบรวมข้อมูล

2. การเปลี่ยนสภาพข้อมูล

3. การลงรหัส

4. การตรวจสอบและปรับแก้ไข

5. ข้อมูลการแปรสภาพข้อมูล

1. ดึงข้อมูล

2. เรียงลำดับข้อมูล

3. การรวมข้อมูล

4. การคำนวณและเปรียบเทียบ

5. การวิเคราะห์ข้อมูลทางสถิติ

1. ตาราง

2. กราฟ

3. ภาพ

4. ข้อความหรือคำอธิบาย

ข้ันตอนการวิเคราะห์ข้อมูล

การเตรียมข้อมูลนำเข้า การประมวลผล การแสดงผล
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3. สร้างฐานข้อมูล : กำหนดรหัสตัวแปร
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B7 ชิ *นสว่นของเนื *อที2ซื *อประจําและการนําไปประกอบอาหาร 
ชิ *นสว่น การประกอบอาหาร (สามารถเลือกได้หลายประเภท) (ทํา üลงในชอ่งวา่ง) 

ต้ม ผดั แกง ทอด ยา่ง สเตก็ ลาบ ชนิดอาหารที2ทํามากที2สดุ 
....... M 1  สนันอก         
....... M 2  สนัใน         
....... M 3  สนัคอ         
....... M 4 ริบอาย         
....... M | เซอร์ลอย         
....... M 6  เสื *อร้องไห้          
....... M 7  สะโพก         
....... M 8  นอ่ง         
....... M 9  ลกูมะพร้าว         
....... M 10  ชายท้อง         
....... M 11  เศษเนื *อ         
....... M 12  ซี2โครง         
....... M 13 ...........................         
....... M 14 ...........................         

B8 คา่ใช้จา่ยเฉลี2ยในการซื *อเนื *อโคสดประมาณ......................................................บาท/ครั *ง 
B9 ชิ *นเนื *อโคที2ทา่นซื *อเป็นประจํา คือ  ....................  ปริมาณ  .................... กิโลกรัม/ครั *ง (โดยประมาณ) 

ราคา  .................... บาท/กิโลกรัม (โดยประมาณ) 
B10 หากเนื *อตวัอยา่งถกูนําบรรจใุสใ่นถาดดงัรูป ทา่นชอบรูปแบบบรรจภุณัฑ์ใด (WTP1) 

   
............ รูปแบบ 1 

ถาดธรรมดา 
............ รูปแบบ 2 
บรรจถุงุสญุญากาศ 

............ รูปแบบ 3 
Skin pack film 

B11 หากเนื *อชิ *นเนื *อโคถกูนําบรรจใุน Skin pack film ดงัรูปแบบ 3 จะทําให้เนื *อมีคณุภาพสดและนุม่ขึ *นกวา่วิธีการบรรจแุบบ
ปัจจบุนั แตมี่ต้นทนุจะเพิ2มสงูขึ *นประมาณ r% ทา่นมีความยินดีจา่ยเพิ2มขึ *นจากเดมิหรือไม ่(WTP2) 
                                  ...... 1) ยินดี   ....... 2) ไมย่ินดี 

 
 
ส่วนที0 2 พฤตกิรรมการบริโภคเมนูอาหารที0ปรุงจากเนื 'อโค 
F1 ความถี2ในการรับประทานเมนจูากเนื *อโคในชว่ง 1 เดือนที2ผา่นมา 
...... 1)    0 ครั *ง ....... 2) 1 - 2 ครั *ง ...... 3)      3 - 4 ครั *ง 
...... 4)    5 - 7 ครั *ง ....... 5) มากกวา่ 7 ครั *ง  
F2 โดยทั2วไปคา่ใช้จา่ยเฉลี2ยในการรับประทานเมนอูาหารที2มีสว่นประกอบเนื *อโคประมาณ.................................... บาท/มื *อ 

• คำถามปลายปิด (Closed-end Question)

รหัสสำหรับการวิเคราะห์ทางสถิติอย่างง่าย เช่น 

ความถี่ ร้อยละ  สามารถกำหนดให้

• เลือกรูปแบบที่ 1 = 1

• เลือกรูปแบบที่ 2 = 2

• เลือกรูปแบบที่ 3 = 3

รหัสสำหรับการวิเคราะห์ทางเศรษฐมติิ กำหนดให้เป็นตัวแปรหุ่น 

(Dummy) โดย

• Pic1 เลือกรูปแบบที่ 1 = 1 ไม่เลือกรูปแบบที่ 1 = 0

• Pic2 เลือกรูปแบบที่ 2 = 1 ไม่เลือกรูปแบบที่ 2 = 0

• Pic3 เลือกรูปแบบที่ 3 = 1 ไม่เลือกรูปแบบที่ 3 = 0
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• คำถามท่ีผู้ตอบเลือกได้มากกว่า 1 คำตอบ (Multiple Response) 
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F3 ประเภทของเมนอูาหารจากเนื *อโคที2ทา่นรับประทานบอ่ยที2สดุ 3 อนัดบัแรก 

...... 1) อาหารตามสั2ง ....... 2) ก๋วยเตีâยว ...... 3) สเตก็ 

...... 4) ปิ *งยา่ง ....... 5) สกีุ */ชาบ/ูจิ *มจุม่ ...... 6) บฟุเฟต์ 

F4 ประเภทของร้านอาหารที2ทา่นไปรับประทานเมนจูากเนื *อโคเป็นประจํา 

...... 1) ร้านส้มตํา/อาหารตามสั2ง ....... 2) ร้านก๋วยเตีâยว ...... 3) ร้านสเตก็ 

...... 4) ร้านปิ *งยา่ง ....... 5) ร้านสกีุ */ชาบ/ูจิ *มจุม่ ...... 6) ร้านอาหารบฟุเฟต์ 

...... ã) ร้านอาหารญี2ปุ่ น/เกาหล/ีจีน ....... 8) อื2น ๆ โปรดระบ ุ..............................  

F5 สถานที2ตั *งของร้านอาหารที2ทา่นรับประทานเนื *อโคเป็นประจํา 

...... 1) ร้านทั2วไป  ....... 2) ร้านในโรงแรม  ...... 3) ร้านในห้างสรรพสนิค้า/คอมมนิูตี *มอลล์   

F6 เนื *อโคที2ทา่นรับประทานบอ่ยที2สดุมาจากแหลง่ใด 

...... 1) เนื *อโคไทย ....... 2) เนื *อโคนําเข้า    ...... 3) เนื *อไทยและนําเข้าใกล้เคียงกนั 

...... 4) ไมท่ราบแหลง่ที2มา       

F7 เนื *อโคที2ทา่นชอบมากที2สดุมาจากแหลง่ใด ...... 1) เนื *อโคไทย ....... 2) เนื *อโคนําเข้า    

F8 เนื *อโคลกัษณะใดที2ทา่นชอบบริโภค ขอให้ทา่นเรียงตามลาํดบัความชอบ 3 อนัดบัแรก 

     โดย 1= ชอบมากที2สดุ 2= ชอบ และ 3= ชอบน้อยที2สดุ 

……. เนื *อโคขนุไทยแบบไมมี่ไขมนัแทรก หรือเนื *อนุม่ 

……. เนื *อโคขนุไทยที2มีไขมนัแทรก 

……. เนื *อโคนําเข้า 

F9 ทา่นใช้เกณฑ์ใดพิจารณาบริโภคเนื *อโค 

...... 1) ราคา ....... 2) คณุภาพ ...... 3) แหลง่ผลติ เชน่ เนื *อไทย เนื *อนําเข้า 

F10 ความเตม็ใจจา่ยสงูสดุตอ่ครั *ง สาํหรับตวัทา่นเองเพื2อรับประทานอาหารที2ปรุงจากเนื *อโค ดงัรายการตอ่ไปนี * 

รายการอาหาร ความเตม็ใจจ่ายสูงสุด (บาท/ครั'ง/คน) 
บฟุเฟต์ชาบทีู2รวมเมนเูนื *อ   

ปิ *งยา่ง/หมกูะทะ  

สเตก็เนื *อโคขนุ 1 จาน หนกัประมาณ 300 กรัม  

เนื *อโคขนุยา่ง 1 จาน  

เนื *อยา่ง 1 จาน  

เนื *อโควากิวยา่ง 1 จาน  

นํ *าตกเนื *อ 1 จาน  

ก๋วยเตีâยวเนื *อโคขนุ 1 ชาม  

ก๋วยเตีâยวเนื *อธรรมดา 1 ชาม  

ข้าวกะเพราะเนื *อ 1 จาน  

 

ส่วนที0 3 พฤตกิรรมการบริโภคสเตก็เนื 'อโค 
S1 ทา่นเคยรับประทานสเตก็เนื *อโคประเภทใดบ้าง (ตอบได้มากกวา่ 1 ข้อ) 

...... 1) สเตก็เนื *อทั2วไป ....... 2) สเตก็เนื *อโคขนุ ...... 3) สเตก็เนื *อโคนําเข้า 

...... 4) สเตก็เนื *อโควากิว ....... 5) ไมเ่คยรับประทานสเตก็เนื *อ  (ข้ามไปส่วนที3 4) 

Dichotomy VariableCategorical Variable

1 = ร้านส้มตำ / อาหารตามส่ัง

2 = ร้านก๋วยเต๋ียว

3 = ร้านเสต็ก
:

:
8 = อื่น ๆ 

ให้สำหรับการวิเคราะห์ทางเศรษฐมิติ กำหนดให้เป็นตัวแปรหุ่น (Dummy)

ตามจำนวนทางเลือกท่ีมี โดย

Resta1 เลือกร้านส้มตำ = 1 ไม่เลือกร้านส้มตำ= 0

Resta2 เลือกร้านก๋วยเตี๋ยว = 1 ไม่เลือกร้านก๋วยเตี๋ยว = 0
Resta3 เลือกร้านสเต็ก = 1 ไม่เลือกร้านสเต็ก= 0

:

:

Resta4 เลือกอ่ืน ๆ = 1 ไม่เลือกอ่ืน ๆ = 0

3. สร้างฐานข้อมูล : กำหนดรหัสตัวแปร
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• คำถามท่ีให้ใส่ลำดับท่ี (Rank Question)

Page - 4 

F3 ประเภทของเมนอูาหารจากเนื *อโคที2ทา่นรับประทานบอ่ยที2สดุ 3 อนัดบัแรก 

...... 1) อาหารตามสั2ง ....... 2) ก๋วยเตีâยว ...... 3) สเตก็ 

...... 4) ปิ *งยา่ง ....... 5) สกีุ */ชาบ/ูจิ *มจุม่ ...... 6) บฟุเฟต์ 

F4 ประเภทของร้านอาหารที2ทา่นไปรับประทานเมนจูากเนื *อโคเป็นประจํา 

...... 1) ร้านส้มตํา/อาหารตามสั2ง ....... 2) ร้านก๋วยเตีâยว ...... 3) ร้านสเตก็ 

...... 4) ร้านปิ *งยา่ง ....... 5) ร้านสกีุ */ชาบ/ูจิ *มจุม่ ...... 6) ร้านอาหารบฟุเฟต์ 

...... ã) ร้านอาหารญี2ปุ่ น/เกาหล/ีจีน ....... 8) อื2น ๆ โปรดระบ ุ..............................  

F5 สถานที2ตั *งของร้านอาหารที2ทา่นรับประทานเนื *อโคเป็นประจํา 

...... 1) ร้านทั2วไป  ....... 2) ร้านในโรงแรม  ...... 3) ร้านในห้างสรรพสนิค้า/คอมมนิูตี *มอลล์   

F6 เนื *อโคที2ทา่นรับประทานบอ่ยที2สดุมาจากแหลง่ใด 

...... 1) เนื *อโคไทย ....... 2) เนื *อโคนําเข้า    ...... 3) เนื *อไทยและนําเข้าใกล้เคียงกนั 

...... 4) ไมท่ราบแหลง่ที2มา       

F7 เนื *อโคที2ทา่นชอบมากที2สดุมาจากแหลง่ใด ...... 1) เนื *อโคไทย ....... 2) เนื *อโคนําเข้า    

F8 เนื *อโคลกัษณะใดที2ทา่นชอบบริโภค ขอให้ทา่นเรียงตามลาํดบัความชอบ 3 อนัดบัแรก 

     โดย 1= ชอบมากที2สดุ 2= ชอบ และ 3= ชอบน้อยที2สดุ 

……. เนื *อโคขนุไทยแบบไมมี่ไขมนัแทรก หรือเนื *อนุม่ 

……. เนื *อโคขนุไทยที2มีไขมนัแทรก 

……. เนื *อโคนําเข้า 

F9 ทา่นใช้เกณฑ์ใดพิจารณาบริโภคเนื *อโค 

...... 1) ราคา ....... 2) คณุภาพ ...... 3) แหลง่ผลติ เชน่ เนื *อไทย เนื *อนําเข้า 

F10 ความเตม็ใจจา่ยสงูสดุตอ่ครั *ง สาํหรับตวัทา่นเองเพื2อรับประทานอาหารที2ปรุงจากเนื *อโค ดงัรายการตอ่ไปนี * 

รายการอาหาร ความเตม็ใจจ่ายสูงสุด (บาท/ครั'ง/คน) 
บฟุเฟต์ชาบทีู2รวมเมนเูนื *อ   

ปิ *งยา่ง/หมกูะทะ  

สเตก็เนื *อโคขนุ 1 จาน หนกัประมาณ 300 กรัม  

เนื *อโคขนุยา่ง 1 จาน  

เนื *อยา่ง 1 จาน  

เนื *อโควากิวยา่ง 1 จาน  

นํ *าตกเนื *อ 1 จาน  

ก๋วยเตีâยวเนื *อโคขนุ 1 ชาม  

ก๋วยเตีâยวเนื *อธรรมดา 1 ชาม  

ข้าวกะเพราะเนื *อ 1 จาน  

 

ส่วนที0 3 พฤตกิรรมการบริโภคสเตก็เนื 'อโค 
S1 ทา่นเคยรับประทานสเตก็เนื *อโคประเภทใดบ้าง (ตอบได้มากกวา่ 1 ข้อ) 

...... 1) สเตก็เนื *อทั2วไป ....... 2) สเตก็เนื *อโคขนุ ...... 3) สเตก็เนื *อโคนําเข้า 

...... 4) สเตก็เนื *อโควากิว ....... 5) ไมเ่คยรับประทานสเตก็เนื *อ  (ข้ามไปส่วนที3 4) 

ชอบมากที่สุด สร้าง Fav1 กำหนดให้1 = เน้ือโคไทยไม่มีไขมันแทรก 

2 = เน้ือโคไทยมีไขมันแทรก

3 = เน้ือโคนำเข้า

ชอบอันดับ 2 สร้าง Fav2 กำหนดให้1 = เน้ือโคไทยไม่มีไขมันแทรก 

2 = เน้ือโคไทยมีไขมันแทรก

3 = เน้ือโคนำเข้า

ชอบอันดับ 3 สร้าง Fav3 กำหนดให้1 = เน้ือโคไทยไม่มีไขมันแทรก 

2 = เน้ือโคไทยมีไขมันแทรก

3 = เน้ือโคนำเข้า

แบบท่ี 1 แบบท่ี 2

LocBeef1 = 1 ถ้าเลือกเน้ือโคไทยไม่มีไขมันแทรก เป็นลำดับที่  1

= 2 ถ้าเลือกเน้ือโคไทยไม่มีไขมันแทรก เป็นลำดับที่  2

= 3 ถ้าเลือกเน้ือโคไทยไม่มีไขมันแทรก เป็นลำดับที่  3

LocBeef2 = 1 ถ้าเลือกเน้ือโคไทยมีไขมันแทรก เป็นลำดับที่  1

= 2 ถ้าเลือกเน้ือโคไทยมีไขมันแทรก เป็นลำดับที่  2

= 3 ถ้าเลือกเน้ือโคไทยมีไขมันแทรก เป็นลำดับที่  3

ImBeef = 1 ถ้าเลือกเน้ือโคนำเข้า เป็นลำดับที่  1

2 ถ้าเลือกเน้ือโคนำเข้า เป็นลำดับที่  2

3 ถ้าเลือกเน้ือโคนำเข้า เป็นลำดับที่  3

กรณี ให้จัดลำดับน้อยกว่าทางเลือกท่ีมีอยู่   

เป็นการให้ผู้ตอบจัดลำดับน้อยกว่าทางเลือกที่มีอยู่  เช่น มีอยู่  5  

ทางเลือกแต่ให้จัดลำดับแค่ 3 ทางเลือก  ซึ่งในกรณีน้ีเราจะพบว่าผู้ตอบ

คำถามอาจจะตอบไม่ครบทั้ง 3 ลำดับก็ได้  ทั้งน้ีเราสามารถกำหนด

วิธีการกำหนดตัวแปรได้ 2 แบบคือ

1. กำหนดให้มีจำนวนตัวแปร =  จำนวนทางเลือก

2. กำหนดให้มีจำนวนตัวแปร =  จำนวนลำดับที่ให้จัด

3. สร้างฐานข้อมูล : กำหนดรหัสตัวแปร
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• คำถามท่ีให้แสดงระดับความมากน้อย (Scale Questions)

2 
 

ส"วนท่ี 1 ข+อมูลการบริโภคเน้ือสัตว= 
BEH1. ทMานชอบรับประทานเนื้อสัตวFประเภทใดมากที่สุด 

☐ 1) เนื้อไกM   ☐ 2) เนื้อหมู   ☐ 3) เนื้อวัว  ☐ 4) เนื้อปลา / ทะเล  ☐  5) อื่น ๆ................. 

BEH2. ความถี่ในการรับประทานเนื้อวัว 

☐ 1) รับประทานเป`นประจำ      ☐ 2) รับประทานบ9างนาน ๆ ครั้ง     ☐ 3) ไมMรับประทานเนื้อวัว 

BEH3. คMาใช9จMายด9านอาหารเฉพาะตัวทMานในการซื้ออาหารประมาณ ............................ บาท/วัน 

BEH4) รูปแบบการรับประทานอาหารของท6านและครอบครัวในช6วง 1 เดือนที่ผ6านมา 
 บ6อยมาก/ประจำ นาน ๆ ครั้ง ไม6เคย 

☐ 1) ทำกับขKาวทานเอง ☐ ☐ ☐ 

☐ 2) ซื้ออาหารสำเร็จรูปมาทานที่บKาน  ☐ ☐ ☐ 

☐ 3) ทานอาหารนอกบKาน  ☐ ☐ ☐ 

BEH5. ทMานชอบรับประทานเบอรFเกอรFชนิดใดมากที่สุด (เลือกตอบเพียง 1 ข9อ) 

☐ 1) หมู       ☐ 2) ไกM     ☐ 3) เนื้อ  ☐ 4) ปลา ☐ 5) มังสวิรัติ 

BEH6. ชุดเบอร์เกอรท์ี่ท่านรับประทานเป็นประจำราคาประมาณ ............................ บาท/ชุด 

BEH7. ในชMวงเทศกาลกินเจ (ตุลาคม 2563) ทMานได9รับประทานอาหารเจหรือไมM  

☐ 1) กินเจตลอดเทศกาล  

  ☐ 2) ไมMได9กินเจ แตMสามารถกินอาหารเจได9 

☐ 3) ไมMกินอาหารเจเลย 
 

ส"วนท่ี 2 ความเห็นต"อการรับประทานเน้ือสัตว=และโปรตีนจากพืช 
คำช้ีแจง : ขอให.ท$านอ$านข.อความด.านล$าง แล.วทำเคร่ืองหมาย   √  ในช$องท่ีตรงกับความคิดเห็นของท$านมากท่ีสุด 

รายการ      
ไม#เห็นด)วย
อย#างย่ิง 

ไม#เห็นด)วย ไม#แน#ใจ เห็นด)วย เห็นด)วย
อย#างย่ิง 

1. เนื้อสัตว์อร่อย      

2. เนื้อสัตว์เป็นแหล่งโปรตีนสำคัญของร่างกาย      

3. การรับประทานเนื้อสัตว์มากส่งผลต่อน้ำหนักตัวที่
เพิ่มขึ้น 

   
  

4. การรับประทานเนื้อสัตว์มากส่งผลเสียต่อสุขภาพ      

5. เพื่อลดความเสี่ยงด้านสุขภาพ ท่านสามารถมาลดและ
เลิกการบริโภคเนื้อสัตว์และผลิตภัณฑ์ได ้

   
  

ID 
_______________ 

1 2 3 4 5

3. สร้างฐานข้อมูล : กำหนดรหัสตัวแปร
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คำถามในแบบสอบถามบางคำถาม ผู้ตอบไม่ต้องตอบทุกข้อ เช่น  ในกรณีเป็นคำถามต่อเนื่อง เช่น 

ท่านรับประทานสเต็กเนื้อโคหรือไม่

(  )  ไม่รับประทาน   (ข้ามไปข้อท่ี S5)           (   )   รับประทาน

S3 ราคาสเต็กท่ีท่านเคยรับประทานแพงท่ีสุด (เฉพาะตัวท่าน) …………………………….. บาท (เฉพาะเมนูสเต็กเท่านั้น)
ถ้าผู้ตอบไม่เคยรับประทานสเต็ก ก็จะไม่ตอบคำถามข้อS3 จึงทำให้ไม่มีคำตอบในข้อนี้  ผู้วิจัยอาจจะกำหนดรหัสสำหรับผู้ท่ีไม่ต้องตอบคำถามใน

ข้อนี้ เป็น 8888 เป็นต้น

ในบางครั้งผู้ตอบจะไม่ตอบคำถามทุกข้อในแบบสอบถาม แต่อาจจะมีการละเว้นไม่ตอบคำถามในบางคำถาม โดยเฉพาะคำถามท่ีต้องแสดง

ความรู้สึกในบางเรื่องหรือคำถามท่ีเก่ียวกับฐานะ เป็นต้น  ซ่ึงการไม่ตอบสามารถสรุปได้ว่า มีสาเหตุ ท่ีสำคัญดังน้ี

1) คำถามน้ันไม่ต้องตอบ (Not Applicable)

ผู้ตอบบางคนอาจไม่ตอบคำถามบางคำถามท้ังท่ีทราบคำตอบ หรือ อาจจะลืมตอบ เช่น ถ้าถามเร่ืองรายได้ แต่ผู้ตอบไม่อยากจะตอบ ก็จะตั้งใจเว้น

คำถามข้อนี้ไว้  ผู้วิจัยอาจจะกำหนดรหัสสำหรับผู้ท่ีไม่ตอบเป็น 9999 เป็นต้น

2) ไม่ตอบ (No Response)

• คำถามท่ีไม่ได้รับคำตอบ (Missing Data)

3. สร้างฐานข้อมูล : กำหนดรหัสตัวแปร



การอบรมการวิเคราะห์สถิติเบื้องต้นด้วยโปรแกรม EXCEL 13

3.สร้างฐานข้อมูล : การจัดทำคู่มือลงรหัส
โดยทั่วไปผู้วิจัยควรจะจัดทำคู่มือการกำหนดรหัส เพื่อให้ผู้พิมพ์ข้อมูลทุกคนเข้าใจได้ตรงกัน และในกรณีที่มีจำนวนคำถามในแบบสอบถามมาก ๆ ผู้พิมพ์หรือผู้ใส่รหัสอาจจะจำได้ไม่ครบ
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ฐานข้อมูล
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www.eatecon.com
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4. การจัดการฐานข้อมูล



การอบรมการวิเคราะห์สถิติเบื้องต้นด้วยโปรแกรม EXCEL 17

Data management with EXCEL

Filter Go to : Home > Sort & Filter Find & Select
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ตรวจสอบข้อมูลในส่วนน้ีว่า 

ในคอลัมน์น้ีมีข้อมูลอะไรบ้าง

การใช้เครื่องมือ Filter: Data -> Filter



การอบรมการวิเคราะห์สถิติเบื้องต้นด้วยโปรแกรม EXCEL 19

การตรวจสอบ Missing value

วิธีการตรวจสอบ missing value สามารถใช<ฟ>งชั่น sum() คูGกับ isblank() เพื่อนับจำนวน cell ท่ีไมGมีข<อมูล 

ถ<าผลลัพธTออกมาเทGากับศูนยTแปลวGาข<อมูลครบ 100%

=SUM(ISBLANK(A1:N507) * 1)

หรือ สามารถใช, countblank() ได,เช;นกัน

=COUNTBLANK(A1:N507)



การอบรมการวิเคราะห์สถิติเบื้องต้นด้วยโปรแกรม EXCEL 20

Insert

Pivot Table
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5. การวิเคราะห์ข้อมูล
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รู้จักข้อมูล

ข้อมูล (Data)

3. อันตรภาคสเกล (Interval scale)

• เป็นการวัดที่ละเอียดกว่า Ordinal scale ในการจัดอันดับ บอกความแตกต่างระหว่างกลุ่มได้ แต่ไม่มีค่าศูนย์ที่แท้จริง e.g. เกรด

A = 4, B=3, C=2, D=1 และ F=0 ซึ่งไม่ได้หมายความว่า ผู้ที่ได้ F ไม่มีความรู้ หรือ ผู้ที่ได้ A ฉลาดเป็นสองเท่าของผู้ที่ได้ C

4. อัตราส่วนสเกล (Ratio scale)

• เป็นข้อมูลที่สมบูรณ์ มีค่าศูนย์ที่แท้จริง บอกความแตกต่างและเปรียบเทียบขนาดของความแตกต่างได้ e.g. รายได้ อายุ น้ำหนัก

ตัวแปรเชิงคุณภาพ

• ไม่ควรหาค่าเฉลี่ยและความ

แปรปรวน

• ควรใช้ความถ่ี หรือร้อยละ

อธิบาย

ตัวแปรเชิงปริมาณ หาค่าเฉลี่ย

และความแปรปรวนได้

Scale of measurement

Scale

1. นามสเกล (Nominal scale)

• เป็นการวัดอย่างง่ายเพ่ือแบ่งกลุ่ม e.g. ชาย (0) หญิง (1)

2. อันดับสเกล (Ordinal scale)

• เป็นการวัดที่ละเอียดกว่า Nominal scale เพ่ือจัดอันดับ บอกความแตกต่างได้ แต่ไม่สามารถบอกได้ว่าแต่คละคนแตกต่างกันมาก

น้อยเพียงใด e.g. เห็นด้วยอย่างยิ่ง (5) เห็นด้วย (4) เฉย ๆ (3) ไม่เห็นด้วย (2) ไม่เห็นด้วยอย่างยิ่ง (1)
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Types of Data Analysis

Comparative Associative Predictive
ความถี่ ร้อยละ ค่าเฉลี่ย 

ส่วนเบ่ียงเบนมาตรฐาน 

ความแปรปรวน 

Descriptive

T-test

One-way ANOVA

G1 G2

Mean Mean

G1 G2

Mean Mean

G3

Mean

One-way ANOVA
Ho: all group means equal
Ha: at least one group different

Post Hoc Comparisons
Ho: two groups mean equal
Ha: two groups mean not equal

Independent t-test
Ho: mean G1 = mean G2
Ha: mean G1 != mean G2

Correlation
Ho: no linear relationship bet Two variables
Ha: there is linear relationship bet two 
variables
* Correlation does not imply causation

Crosstabulation
Ho: no relationship bet Two variables
Ha: there is relationship bet two variables

Chi-square test

Regression
Ho: all coeff. = 0
Ha: at least one coif. != 0

Structural 
Equation 
modelling

(SEM)
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สถิติเชิงพรรณนา (Descriptive statistics)

เป็นหลักการท่ีใช้ในการเก็บรวบรวมข้อมูล นำเสนอข้อมูล และคำนวณค่าสถิติเบื้องต้น ซ่ึงเป็นการอธิบายหรือบรรยายลักษณะของ

ข้อมูลท่ีเก็บรวบรวม แต่จะไม่สามารถอ้างอิงถึงลักษณะประชากรได้ หรืออาจใช้สรุปลักษณะประชากรในกรณีท่ีทำการเก็บรวบรวม

ข้อมูลท้ังหมดของประชากร ดังนั้น สถิติเชิงพรรณนาจึงเป็นการสรุปเฉพาะลักษณะท่ีสำคัญของข้อมูลของท่ีศึกษาเท่านั้น

• การนำเสนอข้อมูลในรูปบทความ

• การนำเสนอข้อมูลในรูปตาราง หรือ ร้อยละ

• การนำเสนอข้อมูลในรูปกราฟ

การนำเสนอข้อมูล

• ค่าเฉล่ีย (Mean)

• มัธยฐาน (Median)

• ฐานนิยม (Mode)

การวัดค่ากลางของข้อมูล

• พิสัย (Range) 

• พิสัยควอไทล์ (Interquartile Range)

• ค่าความแปรปรวน (Variance)
• ค่าเบ่ียงเบนมาตรฐาน (Standard Deviation)

• ค่าความคลาดเคล่ือนมาตรฐานของค่าเฉล่ีย (Standard Error of Mean)
• สัมประสิทธิ์ความแปรผัน (Coefficient of Variation)

• การวัดความเบ้ (Skewness)

• การวัดความโด่ง (Kurtosis)

การวัดการกระจายของข้อมูล
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Install the Data Analysis ToolPak in Excel

To determine whether you have this ToolPak installed, click Data in Excel’s menu across the 
top and look for Data Analysis in the Analyze section. If you don’t see Data Analysis, you need 
to install it. Don’t worry. It’s free!

To install Excel’s Analysis Tookpak, click the File tab on the top-left and then click Options on the bottom-
left. Then, click Add-Ins. On the Manage drop-down list, choose Excel Add-ins, and click Go. On the 
popup that appears, check Analysis ToolPak and click OK.
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Click the Tools menu, and then click Excel Add-ins.

1. In the Add-Ins available box, select the Analysis 

ToolPak check box, and then click OK.

1. If Analysis ToolPak is not listed in the Add-Ins 

available box, click Browse to locate it.

2. If you get a prompt that the Analysis ToolPak is not 

currently installed on your computer, click Yes to 

install it.

3. Quit and restart Excel.

4. Now the Data Analysis command is available on 

the Data tab.

1. Click the File tab, click Options, and then click the Add-

Ins category.

If you're using Excel 2007, click the Microsoft Office Button, 

and then click Excel Options

2. In the Manage box, select Excel Add-ins and then 

click Go.

If you're using Excel for Mac, in the file menu go 

to Tools > Excel Add-ins.

3. In the Add-Ins box, check the Analysis ToolPak check 

box, and then click OK.

• If Analysis ToolPak is not listed in the Add-Ins 

available box, click Browse to locate it.

• If you are prompted that the Analysis ToolPak is not 

currently installed on your computer, click Yes to install 

it.

Load the Analysis ToolPak 

Windows Mac
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Descriptive statistics

TAB: DATA
> Data Analysis
> Descriptive statistics

Given 
A variable in cell 
D1:D89
D1 is variable code 
(label)

Mean AVERAGE(D2:D89)
Standard Error STDEV.S(D2:D89)/SQRT(COUNT(D2:D89))
Median MEDIAN(D2:D89)
Mode MODE(D2:D89)
Standard Deviation STDEV.S(D2:D89)
Sample Variance VAR.S(D2:D89)
Kurtosis KURT(D2:D89)
Skewness SKEW(D2:D89)
Range MAX(D2:D89)-MIN(D2:D89)
Minimum MIN(D2:D89)
Maximum MAX(D2:D89)
Sum SUM(D2:D89)
Count COUNT(D2:D89)

=
=
=
=
=
=
=
=
=
=
=
=
=

=COUNTIF(D2:D89,">=30000")
=COUNTIF(B2:B89,0)
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Independent Samples T-Test

2 groups are significantly different from each other on your continuous vairable, The variable is normally 
distributed, and have a similar spread between your 2 groups. Your 2 groups should be independent (not 
related to each other) and you should have enough data (more than 5 values in each group).

ชาย หญิง

?

ตัวอย่าง

• รายได้ของเพศชายกับเพศหญิงต่างกันหรือไม่

• เพศชายมีความพึงพอใจมากกว่าเพศหญิงหรือไม่
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• รายได้ของเพศชายกับเพศหญิงต่างกันหรือไม่
• รายได้เฉล่ียของเพศชายกับเพศหญิงเท่ากับ 57,000 บาท หรือไม่

• รายได้ของเพศชายมากกว่าเพศหญิงหรือไม่

Independent-Samples T-Test

t-Test: Two-Sample Assuming Unequal Variances

คำถาม
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P-value

𝛼 = 0.1𝛼 = 0.05𝛼 = 0.01
0.321

Non-sig.Sig.

0.0720.0250.0001

Sig. at 0.1Sig. at 0.05Sig. at 0.01

ช่วงความเช่ือม่ัน

ร้อยละ 99
ช่วงความเช่ือม่ัน

ร้อยละ 95

ช่วงความเช่ือม่ัน

ร้อยละ 90
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t-Test : Two-Sample
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สมมติฐาน

ค่าใช้จ่ายเฉล่ียในการบริโภคอาหารของคนท่ี

เข้าร่วมโครงการ A กับ B

คนละครึ่ง VS เราชนะ

t-Test : Two-Sample assuming equal variances
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t-Test : Two-Sample assuming unequal variances

ค่าใช้จ่ายเฉล่ียในการบริโภคอาหารของคนท่ี

เข้าร่วมโครงการ A กับ B

คนละครึ่ง VS เราชนะ
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Paired Samples T-Test

The Paired Samples T-Test is also called the Paired Sample T-Test, Dependent Sample T-Test and the Paired T-Test.

Time 1 Time 2
ก่อน หลัง

?

The assumptions for the Paired 
Samples T-Test include:
1. Continuous
2. Normally Distributed
3. Random Sample
4. Enough Data : more than 5 

obs. each is OK. If your 
sample size is greater than 
30 should use Paired Z-test.

5. Similar Spread Between 
Groups

Note: A Paired Samples T-
Test can only be used to 
compare two groups (i.e. two 
observations from one 
group) on your variable of 
interest.

Paired t-tests assess paired observations, which are often two 
measurements on the same person or item. 
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สมมติฐาน

ค่าใช้จ่ายเฉลี่ยในการบริโภคอาหารต่อวันก่อนมีมาตรการ น้อย

กว่า ค่าใช้จ่ายเฉลี่ยในการบริโภคอาหารต่อวันหลังมีมาตรการ

เปรียบเทียบ
ก่อนมีมาตรการ VS หลังมีมาตรการ

Paired t-Tests
1. From the Data Analysis popup, choose 

t-Test: Paired Two Sample for Means.
2. Under Input, select the ranges for both 

Variable 1 and Variable 2.
3. In Hypothesized Mean Difference, you’ll 

typically enter zero. This value is the null 
hypothesis value, which represents no 
effect. In this case, a mean difference of 
zero represents no difference between 
the two methods, which is no effect.

4. Check the Labels checkbox 
5. Alpha value = 0.05
6. Click OK.
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ค่าใช้จ่ายเฉลี่ยในการบริโภคอาหารแต่ละอาชีพแตกต่างกัน

เปรียบเทียบ

ระหว่างประชากร/หลายกลุ่ม ว่างงาน อาชีพอิสระ พนักงานเอกชน พนักงานภาครัฐ

One way ANOVA

An analysis of variance (ANOVA) is used to compare 
the means of two or more independent samples
and to test whether the differences between the 
means are statistically significant. The one-way 
analysis of Variance (one-way ANOVA) can be 
thought of as an extension of a t- test for 
independent samples. It is used when there are two 
or more independent groups.

𝐻!: 𝜇" = 𝜇# = 𝜇$. . . = 𝜇%
𝐻!: Not all the means are equal

สมมติฐาน

คำถาม
ค่าใช้จ่ายเฉลี่ยในการบริโภคอาหารแต่ละอาชีพแตกต่างกัน

หรือไม่
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One way ANOVA
Go to : Data > Data Analysis > Anova: Single Factor
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Chi-Square Test for Independence

H0 : Variable A is independent of variable B
H1 : Variable A is not independent of variable B

H0 : There is no relationship between the variables.
H1 : There is a relationship between the variables.

The Chi Square statistic is commonly used for testing relationships between 
categorical variables. The null hypothesis of the Chi-Square test is that no 
relationship exists on the categorical variables in the population; they are 
independent.
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Chi-square test

E3 =COUNTIFS(A2:A89,"1",B2:B89,"1")

E4 =COUNTIFS(A2:A89,"1",B2:B89,"1")

E10 = E12*G10/G12

0.68632209

E11 = E12*G11/G12
F10 = F12*G10/G12
F10 = F12*G11/G12
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Multiple linear regression
𝑸𝒖𝒂𝒏 = 𝜷𝟎 + 𝜷𝟏𝑺𝒆𝒙 + 𝜷𝟐𝑨𝒈𝒆 + 𝜷𝟑𝑰𝒏𝒄 + 𝜷𝟒𝑬𝒅𝒖 + 𝜷𝟓𝑺𝒕𝒖 + 𝜷𝟔𝑴𝒆𝒎+ 𝜺

Sig at 0.01
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𝑸𝒖𝒂𝒏 = 𝜷𝟎 + 𝜷𝟏𝑺𝒆𝒙 + 𝜷𝟐𝑨𝒈𝒆 + 𝜷𝟑𝑰𝒏𝒄 + 𝜷𝟒𝑬𝒅𝒖 + 𝜷𝟓𝑴𝒆𝒎+ 𝜷𝟔𝑳𝒂𝒏𝒅 + 𝜷𝟕𝒀𝒆𝒂𝒓 + 𝜺

Multiple linear regression

Sig at 0.01

Sig at 0.05

ผลของสมการถดถอยชี้ให้เห็นว่า จำนวนรอบการ

ปลูกข้าวในแต่ละปีส่งผลเชิงบวกต่อปริมาณการซ้ือ

เมล็ดพันธุ์ในแต่ละคร้ัง

โดยจำนวนรอบการผลิตเพ่ิมข้ึน 1 รอบจะส่งผลต่อ
ปริมาณการซ้ือเมล็ดพันธุ์ข้าวเพ่ิมข้ึน 0.02 กิโลกรัม

ต่อคร้ัง ท่ีระดับนัยสำคัญทางสถิติ 0.05
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6. การนำเสนอข้อมูล
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Home

Insert

Presentating the data
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